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IDENTIFY GOOD DATABASE DESIGN 

A database is an organized collection of data – facts about people, events, things, or ideas – related to a 

specific topic or purpose.  Information is data that is accurate, timely, and organized in a useful manner.  Your 

contact list is a type of database, because it is a collection of data about one topic – the people with whom you 

communicate.  A simple database of this type is called a flat database because it is not related or linked to 

any other collection of data.  Another example of a simple database is your music collection.  You do not keep 

information about your music collection in your contact lit because the data is not related to the people in your 

contact list.  

A more sophisticated type of database is a relational database, because multiple collections of data in the 

database are related to one another.  For example, data about the students, the courses, and the faulty 

members at a college.  Microsoft Access is a relational database management system, also referred to as a 

DBMS which is software that controls how related collections of data are stored, organized, retrieved, and 

secured.  

Objects are the basic parts of a database; you create objects to store your data, to work with your data, and to 

display your data.  The FOUR database objects are tables, queries, forms and reports. Think of an Access 

database as a container for the objects that you create. 

Using Good Design Techniques to Plan a Database 
Before creating a new database, the first step is to determine the information you want to keep track of by 

asking yourself, What questions should this database be able to answer?  The purpose of a database is to 

store the data in a manner that makes it easy to find the information you need by asking questions.  For 

example, in a student database, the questions to be answered might include: 

• How many students are enrolled at the college? 

• How many students have not yet been assigned a faculty advisor? 

• Which students live in Phoenix, Arizona? 

• Which students owe money for tuition? 

• Which students are majoring in Information Systems Technology? 

Tables are the foundation of an Access database because all of the data is stored in one or more tables.  A 

table is similar in structure to an Excel worksheet because data is organized into rows and columns. Each table 

row is a record – all of the categories of data pertaining to one person, place, even, thing, or idea.  Each table 

column is a field – a single piece of information for every record.  For example, in a table storing student 

contact information, each row forms a record for only one student. Each column forms a field for every record – 

for example, the student ID number or the student first name. 

When organizing the fields of information in your table, break each piece of information into its smallest, most 

useful part.  For example, create three fields for the name of a student – one field for the last name, one field 

for the first name, and one field for the middle name or initial.  

The tables of information in a relational database are linked or joined to one another by a common field – a 

field in two or more tables that stores the same data.  For example, a Students tables include the Student ID, 

name and full address of every student.  The Student Activities table includes the club name and the Student 

ID of members, but not the name or address, of each student in the club.  Because the two tables share a 

common field – Student ID – you can use the data together to create a list of names and addresses of all of the 
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students in a particular club.  The names and addresses are stored in the Students table, and the Student IDs 

of the club members are stored in the Student Activities table. 

The first principle of good database design is to organize data in the tables so that redundant – duplicate – 

data does not occur.  For example, record the student contact information in only one table, so that if a 

student’s address changes, you can change the information in just one place.  This conserves space, reduces 

the likelihood of errors when inputting new data, and does not require remembering all of the places where a 

student’s address is stored.  

The second principle of a good database design is to use techniques that ensure the accuracy and 

consistency of data as it is entered into the table. Proofreading data is critical to maintaining accuracy in a 

database.  Typically, many different people enter data into a database – think of all the people who enter data 

about students at your college.  When entering a state in a student contacts table, one person might enter the 

state as Texas, while another might enter the state as TX.  Use design techniques to help those who enter 

data into a database to enter the data more accurately and consistently.  

Normalization is the process of applying design rules and principles to ensure that your database performs as 

expected.  Taking the time to plan and create a database that is well designed will ensure that you can retrieve 

meaningful information from the database.  

CREATE A TABLE AND DEFINE FIELDS IN A BLANK DESKTOP 

Three methods are used to create a new Access database.  One method is to create a new database using a 

database template – a preformatted database designed for a specific purpose.  A second method is to create 

a new database from a blank desktop database.  A blank desktop database is stored on your computer or 

other storage device.  Initially, it has no data and has no database tools; you create the data and the tools as 

you need them.  A third method is to create a custom web app database from scratch or by using a template 

that you can publish and share with others over the Internet.  

Regardless of the method you use, you must name and save the database before you can create any objects 

in it.  Objects are the basic parts of a database; you create objects to store your data, to work with your data, 

and to display your data.  The four database objects are tables, queries, forms and reports. Think of an 

Access database as a container for the objects that you create.  

Create a Blank Desktop Database 
1. Open Access 

2. Click Blank database.  Notice: in the File Name box, Database1 displays as the default file name. This 

will be changed next.  Do not type a name here – it may get lost! 

3. Click Browse in the right of the File Name box. 

 

Navigate where you will save your database in File 

Explorer. 

4.   Create a New Folder named Access Chapter 1 

and press Enter.  

5. Click in the File name box, type 

 Your Initials 1A_Student_Advising.  

For example, for Jackie Strobel the database file name 

would be JS 1A_Student_Advising.  Click OK.  

Click Create.  
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Access creates a new database and opens Table1 

 
 

After you have named and saved your database, in a real-world application, the next step would be to consult 

your database design plan and then create the tables for your data.  Limit the data in each table to one subject.  

A new blank table is displayed in Datasheet view which displays the data in columns and rows.  Another way to 

view a table is in Design view, which displays the underlying design – the structure – of the table’s fields.  

The object window displays the open object – in this instance, the Table1 object.  

 

 

In a new blank database, there is only one object – a new blank table.  Because the table has not been named, 

the object tab displays the default name Table1.  Access creates the first field and names it ID.  In the ID field, 

Access assigns a unique sequential number – each number incremented by one – to each record as it is 

entered into the table.  

Each column in a table is a field.  Field names are displayed at the top of each column of the table.  Each row 

in a table is a record – all of the data pertaining to one person, place, thing, event, or idea.  Each record is 

broken up into its smallest usable parts – called fields. Use meaningful names for fields: for example, Last 

Name.  
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The Navigation Pane displays and organizes the names of the objects in a database.  From the Navigation 

Pane, you can open objects. Collapse or close the Navigation Pane to display more of the object – in this case, 

Table1.  

 

Explore:  In the Navigation Pane, click the Shutter Bar Open/Close to collapse the Navigation Pane to a 

narrow bar on the left.   

 

 

 

Determine Data Types for Fields 
A data type classifies the kind of data you can store in a field, such as numbers, text, or dates. For each field 

in your database, you must determine the field’s data type.  Only one data type can exist in a field.   After 

selecting the data type, you can name the field. The four commonly used data types in Access are Short Text, 

Number, Currency, and Date & Time.   

The table below shows a complete list of data types with a description.  

 

TIP:  Press F11 to close or open the Navigation Pane 
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DATA TYPE  DESCRIPTION 

AutoNumber Field stores a unique sequential number that Access assigns to a record.  Access will increment 
the number by 1 as each new record is added. Use this when records have no unique value. 
This is the Default data type for New Tables  

Short Text A field with a combination of text, numbers or numbers that do not represent a quantity or are 
not used in calculations such as: postal codes, SSN, Driver’s License, Student ID number 

A maximum number of 255 characters is allowed in a field. 

Number The field can contain only numbers.  The numbers can be either positive or negative.  Number 
Fields can be used in arithmetic operations.   

Currency The field can contain only monetary data.  The values will appear with currency symbols, 
commas, and decimal point followed by two digits.  Currency fields can be used in arithmetic 
operations.  Access assigns a size to currency fields automatically.  

Date & Time The field can contain dates and/or times 

Calculated Field specified as a calculation based on other fields.  The value is not actually stored. 

Long Text Field can store a variable amount of text or combinations of text and numbers where the total 
number of characters may exceed 255.  

Yes/No Field can store only one of two values.  The choices are Yes/No, True/False, or On/Off 

OLE Object Field can store an OLE object, which is an object linked to or embedded in the table 

Hyperlink Field can store text that can be used as a hyperlink address 

Attachment Field can contain an attached file, images, spreadsheets, documents, charts, and other 
elements can be attached to this field in a record in the database.  You can view and edit the 
attached file.  

Assign Data Types and Names to Fields 
1. In the field names row, click down arrow next to Click to Add to display a list of data types. DO NOT 

CLICK IN THE BLANK BOX.  Photo below is not a full list of items.  

 

TYPING FIELD NAMES MUST BE PERFECT.  NO TYPOS.  IF THEY ARE NOT 

PERFECT, WHEN YOU IMPORT LATER. YOU WILL HAVE PROBLEMS. 

2. Click Short Text. The Click to Add changes to Field1 and is selected.   

3. Type Last Name and press Enter.  The second column displays Last Name as the field name and in 

the third column the data type list displays.  

TIP:  With the list of data types displayed, type the character that is underscored to select the data type.  

For example, type t to select Short Text or type u to select Currency. 
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4. While the list is still displayed, in the third field box, type t to select Short Text, type First Name and 

press Enter  

5. In the fourth field name box, click Short Text, type Middle Initial and press Enter 

6. Create the remaining from the table below. PRETEND THE LABELS ARE ON ONE ROW NOT TWO 

OR THREE.  First select the data type, type the field name, and press Enter. The field names in the 

table will display on one line. Field names will not completely display in the column, but will be adjusted 

later.  Access automatically creates the ID field.  The default data type is AutoNumber. 

Data 
Type 

 Short 
Text 

Short 
Text 

Short 
Text 

Short 
Text 

Short 
Text 

Short 
Text 

Short 
Text 

Short 
Text 

Short 
Text 

Short 
Text 

Currency 

Field 
Name 

ID Last 
Name 

First 
Name 

Middle 
Initial 

Address City State Postal 
Code 

Phone Email Faculty 
Advisor 
ID 

Amount 
Owed 

 

Another way to Create Fields... 

You can create a new field in Datasheet view by typing the data in a new column.  Access automatically 

assigns a data type based on the data you enter.  For example, if you enter a date, Access assigns the Date & 

Time data type.  If you enter a monetary amount, Access assigns the Currency data type.  If Access cannot 

determine the data type based on the data entered, the Short Text data type is assigned.  You can always 

change the data type if an incorrect data type is assigned.  If you use this method to create fields, you must 

check the assigned data types to ensure they are correct.  It is vital you rename the fields because Access 

assigns the names as Field1, Field2, etc. which is not appropriate.  

Rename Fields and Change Data Types in a Table 
Field names need to be clear.  In the Enter Field Properties dialog box, you have the option to use the Caption 

property to display a name for a field different from the one that displays in the Name box.  Many database 

designers do not use spaces in field names; instead, they may name a field LastName or LName and then 

create a caption for the field so it displays as Last Name in tables, forms, or reports.  In the Enter Field 

Properties dialog box, you can also provide a description for the field. 

Another way to rename…right click the field name to display the shortcut menu, and then click Rename Field, 

or double-click the field name to select the existing text, and then type the new field name.    

1. In the first column, click anywhere in the text ID  

2. Click the Table Fields tab, in the Properties group, click Name & Caption button.  

3. In the Enter Field Properties dialog box, in the Name box, change ID to Student ID, click OK 
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4. In the Formatting group, notice the Data Type is AutoNumber for the Student ID field. This is the 

default.  

 

5. Click the Data Type arrow, click Short Text.   

Notice the Student ID number is now left aligned which means this is text and no longer a number  

 

In the new record row, the Student ID field is selected.  By default, Access creates an ID field for all new tables 

and sets the data type for the field to AutoNumber.  The AutoNumber data type describes a unique 

sequential or random number assigned by Access as each record is entered.  Changing the data type of this 

field to Short Text enables you to enter a custom Student ID number.  

When records in a database have no unique value, such as a book ISBN or a license plate number, the 

AutoNumber data type is a useful way to automatically create a unique number.  This ensures every record is 

different from the others. 

Adding a Record to a Table 
A database is meaningless until you populate it with one or more tables with data. You can populate a table 

with records by typing data directly into the table.  The pencil icon in the record selector box indicates that a 

record is being entered or edited.  The record selector box is the small box at the left of a record in Datasheet 

view.  When clicked, the entire record is selected.  

 

Pressing Enter or Tab in the last field moves the insertion point to the next row.  Access automatically saves 

the record as soon as you move to the next row.    

Correcting Typing Errors:  Use the Backspace or Delete keys as you would in other Office applications.  

Press the Escape key to exit out of a record that has not been completely entered.  

1. In the first new record row, under the field Student ID click in the field to display the insertion point; 

type 1023045.  Press Enter 

 

2. In the Last Name field, type Fresch and press Enter 

3. In the First Name field, type Jenna and press Enter 
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4. In the Middle Initial field, type A and press Enter 

5. In the Address field, type 7550 Douglas Ln and press Enter 

6. Continue entering the data in the fields as shown in the table below, pressing Enter to move to the next 

field 

City State Postal Code Phone Email Faculty Advisor ID 

Austin TX 78749 (512) 555-7550 jfresch@ticc.edu FAC-2289 

7. In the Amount Owed field, type 250 and press Enter.  

8. Click the Save button on the Quick Access Toolbar 

9. In the Save As dialog box, in the Table Name box, type your initials 1A Students. For example: for 

Jackie Strobel the name would be JS 1A Students  

Save each database object with a name that identifies the data that is contains.  When you save 

objects within a database, it is not necessary to use underscores in place of the spaces between words.   

10. In the Save As dialog box, click OK 

 

Rename or Deleting a Table:  To change the name of a table, close the table, display the Navigation Pane, 

right-click the table name, click Rename.  Type the new name or edit as you would any selected text.  To 

delete a table, close the table, display the Navigation Pane, right-click the table name, and the click Delete. 

 

Adding Additional Records to a Table 
1. In a new record row, enter the data for two additional students as shown in the table below; Press Enter 

or Tab to move from field to field.   

 

Student 
ID 

Last 
Name 

First 
Name 

Middle 
Initial 

Address City State Postal 
Code 

Phone Email Faculty 
Advisor ID 

Amount 
Owed 

2345677 Ingram Joseph S 621 Hilltop Dr Leander TX 78646 (512)  
555-0717 

jingram@ticc.edu FAC-2377 378.5 

3456689 Snyder Amanda J 4786 Bluff St. Austin TX 78610 (512) 
555-9120 

asnyder@ticc.edu FAC-9005 0 

 

Import Data from Excel Workbook 
You can type records directly into a table and you can import data from a variety of sources.  Importing is the 

process of copying data from one source or application to another application.  For example, you can import 

data from a Word table or an Excel spreadsheet into an Access database because the data is arranged in 

columns and rows, similar to a table in Datasheet view.   

There are three options for importing data specifically from an Excel spreadsheet:  

   1. Import the data into a new table in the current database  

   2. Append a copy of the records to an existing table   

   3. Link the data from the spreadsheet to a linked table in the database.   

A link is a connection to data in another file.  When linking, Access creates a table that maintains a link to 

the source data, so that changes to the data in one file are automatically made in the other – linked – file.  

 

mailto:jfresch@ticc.edu
mailto:jingram@ticc.edu
mailto:asnyder@ticc.edu
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In the following step the Append method will be use.  Append means to add data from an Excel spreadsheet 

to your 1AStudents Table.   To append data, the table in Access must already be created, and it must be 

closed.  

1. If not already done, download the data file a01A_Students that is located in Canvas and save it in your 

Access Chapter 1 folder.  

 

2. Click the Object Close button located on the upper right corner to close the 1AStudents table.  There 

should be no objects opened.  

 

 

3. Click the External Data tab.  In the Import & Link group, click New Data Source button, point to From 

File; click Excel 

 

 

4. The Get External Data – Excel Spreadsheet dialog box opens; Click Browse.   

The File Open in File Explorer opens.   Navigate to where you saved the Excel file a01A_Students.  

Note: The path to the source file (the file being imported) displays in the File name box of the Get 

External Data – Excel Spreadsheet dialog box.  

 

5. Click the Append a copy of the records to the table option button.   

Note: Since only one table exists, the table listed is Your initials 1A Students.  When you have multiple 

tables, click the down arrow and select the table you want to append records to. The table into which 

you import or append data is referred to as the destination table.  
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6. Click OK. 

If a security message displays, click Open.  

The first screen of the Import Spreadsheet Wizard displays.  A wizard is a feature in Microsoft Office 

program that walks you step by step through a process. The presence of scroll bars in the window 

indicates that records and fields are out of view.   

 

To append records from an Excel workbook to an existing database table, the column headings in the 

Excel worksheet or spreadsheet must be identical to the field names in the table.  The wizard identified 

the first row of the spreadsheet as column headings, which are equivalent to field names. 
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7. Click Next.  

The name of the table to Import to displays under Import to Table.   

8. Click Finish located in the lower right corner 

9. In the Get External Data – Excel Spreadsheet dialog box, click Close 

 

10. Open the Navigation Pane 

11. If needed, display the double headed arrow on the right edge of the Navigation Pane, click and drag to 

the right to increase the width to view the entire table name. 

 

 
 

12. In the Navigation Pane, double-click the 1A Students table to open it in Datasheet view 

13. In the lower left corner, locate the navigation area that shows a total of 25 records in the table – you 

entered three and imported 22.  

The navigation area has controls in the form of arrows to click to move through the records as well as to 

add a new record  

 

 
 

CHANGE THE STRUCTURE OF TABLES AND ADD A SECOND TABLE 

The structure of a table is the underlying design of the table and includes field names and data types.  You can 

create or modify a table in Datasheet view.  To define and modify fields, many database experts prefer to work 

in Design view, where you have more options for defining fields in a table. 

There are two views for tables:  Datasheet view and Design view.  Other objects have different views.   
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Datasheet view is represented by a picture of a table arranged in columns and rows.  In the Views group, if 

the top of the View button displays the ruler and protractor, that means you are in Datasheet View.  Clicking 

the View button toggles you between the Datasheet and Design View. 

Design View is represented by a ruler and protractor.  If the View button displays a table format of columns 

and rows, this means you are in Design View.  

Design View displays the underlying design, the structure, of the table and its fields.  In Design view, the 

records in the table do not display.  In Design view, you can only view the information about each field’s 

attributes.  Each field name is listed, along with its data type.  You can add explanatory information about a 

field in the Description column, but it is not required. Lastly, in Design View, you can decide how each field 

should look and behave in the Field Properties area.  For example, you can set a specific field size in the Field 

Properties area.  In the lower right corner, information displays about the active selection such as the Field 

Name. 

In addition, you can click the bottom part of the Views button and make your selection from the drop down list.  

 

 

Delete a Table Field in Design View 
1. Click the Home tab, in the Views group, click the View arrow  

2. Click Design View 

3. In the Field Name column, to the left of Middle Initial, point to the row selector box to display the right 

black arrow pointer,        then click once to select the row. Tap the Delete key on your keyboard.  

 

 Currency 
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The following message will appear.  Click Yes.  

 

 

Other Ways to Delete a field…. 

1.  Select the field in Design View, in the Table Design tab, in the Tools group, click Delete Rows.  

 
 

2. Select the field in Design View, right-click on the row and select Delete Rows 

 
 

3. In Datasheet view, select the field – column (move mouse over field name until a black down arrow 

appears), click to select, on the Home tab, in the Records group, click Delete button 
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MORE KNOWLEDGE:  Add a Table Description 

You can create a description to provide more information to users regarding the entire table. With the table 

displayed in Design view, click the Design tab.  In the Show/Hide group, click Property Sheet.  Click in the 

Description box, type the table description, and then press Enter. Close the Property Sheet. 

Deleting the field deletes both the field and its data. After you save the changes, you cannot undo this action. 

 

Change Field Size and Add a Description 
Typically many different individuals have the ability to enter data into a table. For example, at a college, 

Registration Assistants enter and modify student and course information daily.   Two ways to help reduce 

errors are to restrict what can be typed in a field and to add descriptive information.  

1. In Design view, in the Field Name column, click anywhere in the Student ID field name 

2. In the lower part of the screen, under Field Properties, click Field Size to select 255 and type 7. 

This limits the number of characters.  No more than 7 characters can be entered. However, this does 

not eliminate the fact that the 7 characters could be wrong or if less than 7 characters are entered.  

 

3. In the Student ID row, click the Description box, type Seven-digit Student ID number and press 

Enter.  

Note: Descriptions for fields in a table are optional.  

4. Click in the State field name box. In the Field Properties, change the Field Size to 2; in the 

Description box type Two-character state abbreviation and press Enter 

5. Click in the Faculty Advisor ID field name box. In the Field Properties, change the Field Size to 8; in 

the Description box type Eight-character ID of the instructor assigned as advisor and press Enter 

6. Click Save in the Quick Access Toolbar 

Observe the message informing you that if more characters exist, the data will be truncated (cut off or 

shortened). Click Yes 

 

View Primary Key in Design View 
Primary key refers to the required field in the table that uniquely identifies a record.  For example in a college 

registration database, your Student ID number identifies you as a unique individual.  Other examples include a 

Social Security Number, a driver’s license, license plate number, or a Patient ID number.  In the 1A Students 

table, the Student ID uniquely identifies each student.  

When you create a table using the blank desktop database template, Access designates the first field as the 

primary key field and names the field ID. However, you can set any field as the primary key by clicking the field 
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name, and then in the Tools group, click Primary Key.  It is good database design practice to establish a 

primary key for every table, because doing so ensures that you do not enter the same record more than once. 

1. In Design view, in the Field Name column, click in the Student ID box.  To the left of the box, notice 

the small icon of a key.  This is for observation purposes only.  No action is needed.  

 

2. On the Design tab, in the Views group, notice the View button displays a picture of a datasheet, 

indicating that clicking the View will switch to Datasheet view.  Click the top of the View button.  

Note: If you make design changes to a table and switch views without first saving the table, Access 

will prompt you to save the table before changing views.  

3. Close the table 

Add a Second Table to a Database by Importing an Excel Spreadsheet 
Microsoft Excel is used to track data.  The sorting and filtering capabilities of Excel are useful for a simple 

database where all of the information resides in one large Excel spreadsheet.  However, Excel is limited as a 

database management tool because it cannot relate the information in multiple spreadsheets in a way that you 

can ask a question and get a meaningful result.  Because data in an Excel spreadsheet is arranged in columns 

and rows, the spreadsheet can easily convert to an Access table by importing the spreadsheet. 

1. Click the External Data tab, and then in the Import & Link group, click New Data Source button, point 

to From File, click Excel.  In the Get External Data – Excel Spreadsheet dialog box, to the right of the 

File name box, click Browse 

2. In the File Open dialog box, navigate to where you saved the data file a01A_Faculty_Advisors and 

double click on it.  

3. Be sure the Import the source data into a new table in the current database option is selected; click 

OK. If a security message displays, click Open. 

 
Note: The Import Spreadsheet Wizard displays the spreadsheet data   

 

4. In the upper left corner of the wizard, select the First Row Contains Column Headings check box. 

Note:  The Excel data is framed, indicating that the first row of Excel column titles will become the 

Access table field names, and the remaining rows will become the individual records in the new table.   
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5. Click Next.  

Notice that the first column – Faculty ID – is selected, and in the upper area of the wizard, the Field 

Name and the Data Type display.  

Note: In this step, under Field Options, you can review and change the name or the data type of each 

selected field.  You can also identify fields in the spreadsheet that you do not want to import into the 

Access table by selecting the Do not import field (Skip) check box  

 

6. Click Next 

7. In the upper area of the wizard, click the Choose my own primary key option button and be sure that 

Faculty ID displays. 

Note: In the new table, Faculty ID will be the primary key.  By default, Access selects the first field as 

the primary key, but you can click the arrow and select a different field.  

 

 
 

8. Click Next 

9. In the Import to Table box, use Your initials 1A Faculty Advisors.  For example, for Jackie Strobel 

the name would be JS 1A Faculty Advisors. Click Finish 

10. In the Get External Data – Excel Spreadsheet dialog box, click Close 

11. Open the Navigation Pane, double click your 1A Faculty Advisors table to open it in Datasheet view.  

If desired you can close the Navigation Pane.   

12. In your 1A Faculty Advisors table, click in the Postal Code field in the first record.  Under Table 

Fields, in the Formatting group, notice the Data Type is Number.  Why is this wrong?  Because you will 

never use the Postal Code for calculations.  Click the Data Type arrow, click Short Text.  The labels 

are now left aligned to denote text. 

7 

 

TIP:  When you import data from an Excel spreadsheet, check the data types of all fields to ensure they are 

correct.  If a field, such as the Postal Code, contains numbers that do not represent a quantity or are not used 

in calculations, the data type should be set to Short Text.  
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Adjust Column Widths 
Adjust column widths in a table displayed in Datasheet view by using techniques similar to those used for 

Excel spreadsheet. 

Clicking an Object tab along the top of the object window enables you to display the open object and make it 

active.  All the columns in the datasheet are the same width, regardless of the length of the data in the field, 

the length of the field name, or the field size.  If you print the table as is, some of the data or field names will 

not print completely, therefore adjusting column widths is necessary. 

Various ways to change the width of a column:   

1. Use the solid cross with double arrow (like Excel) click hold and drag 

 
 

2. Use the solid cross with double arrow and double click 

3. Use the solid black down arrow to select field name, right click, select Field Width, click Best Fit 

4. Select Field Name, use the More command in the Home tab in the Records group and select Field 

Width and select Best Fit 

 
 

5. Use the Select All feature to change the width of all columns at one time using the More option 
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Like Excel, you can select multiple columns and adjust the column width using any of these 

methods. 

In Access, adjusting the column width to fit the contents is referred to as Best Fit.  

1. Click the object tab for your 1A Students table 

2. Using any of the methods listed above, change the width of Address, City, Email and All the Fields so 

all the data is in full view. 

3. Click Save on the Quick Access Toolbar to save the table design changes.   

If you don’t save the table, Access prompts you to save it when you close the table 

Print a Table, Orientation, Headers & Footers 
You may print a table as a quick reference or to proofread the data that has been entered.  

1. Click the File tab, click Print, click Print Preview 

Note: The table displays in Print Preview with the default Zoom setting of One Page, a view that 

enables you to see how your table will print on the page.  It is good to view any object in Print Preview 

before printing so you can make changes before printing. 

 

In the navigation area, the Next Page button is darker which means that more than one page will print.  

When the Next Page is dimmed, it means there are no more pages to print. 

 

2. In the Navigation area, click Next Page to display page 2 

3. Point to the top of the page to display the magnifying glass pointer, click once to zoom in. 

Note: The Print Preview display enlarges, and the Zoom Out pointer displays.  The second page of the 

table displays the last five fields. The Next Page button is dimmed, indicating that the button is 

unavailable because there are no more pages after Page 2.  The Previous Page button is available, 

indicating that a page exists before this page.  

4. On the Print Preview tab, in the Zoom group, click Zoom to change the setting back to One Page 

5. In the Page Layout Group, click Landscape. 

 

 
 

Notice:  there are three fields on Page 2.  

If needed, in the navigation area, click Previous Page to display Page 1 

The orientation of the page to be printed changes.   

 

The header on the page includes the table name and current date, and the footer displays the page 

number.  The change from portrait orientation to landscape is not saved with the table. Each time you 
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print, you must check the page orientation, the margins and any other print parameters so that the 

object prints as you intend.   

 

 

 

 

 

 

 

 

The following steps will guide you in preparing your object as an electronic image (or PDF).  

PLEASE NAME FILES AS INDICATED  

6. While in Print Preview, click PDF or XPS in the Data group  

 
Navigate to your Access folder and save the object as Your Initials Students 1 of 5.   

For example, for Jackie Strobel the name would be JS Students 1 of 5  

Note:  If you wish to view the PDF file, in the dialog box, select the Open file after publishing check box.  

7. Click Publish.  Wait for the process, If needed, close any window that displays your PDF; Close the 

Export – PDF dialog box.  If the Save Export Steps dialog box appears, click Close. On the ribbon, click 

Close Print Preview; your electronic image is saved.   

WHEN DONE CORRECTLY, THE STUDENTS FILE WILL BE ON LANDSCAPE ON 2 PAGES 

8. Close the 1A Students table by clicking the Close Object in the upper right corner of the object. 

Notice:  the 1A Faculty Advisors table is the active object in the object window. 

 

 

 

9. In your 1A Faculty Advisors table, click the Select All button.  

10. On the Home tab, in the Records group, click More, click Field Width; in the Column Width dialog 

box, click Best Fit. Click in any field to de-select. Scroll vertically and horizontally to verify all content is 

in full view.  Save any changes. 

11. Click the File tab, click Print, click Print Preview, click Landscape in the Page Layout Group.  In the 

Page Size group, click Margins, click Normal.  This will be on two pages. 

Prep for 2 of 5 

NOTE: HEADERS AND FOOTERS IN ACCESS OBJECTS 

The headers and footers in Access tables and queries are controlled by default settings; you cannot enter 

additional information or edit the information.  The object name displays in the center of the header area, 

and the current date displays on the right.  Adding your name to the object name is helpful in identifying your 

paper printouts or electronic results.  The page number displays in the center of the footer area.  The headers 

and footers in Access forms, and reports are more flexible to add or edit the information.  

Prep for 1 of 5 
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12. In the Data group, click PDF or XPS, navigate to your Access folder and save the object as Your 

initials Faculty Advisors 2 of 5.  

For Example, for Jackie Strobel the name would be JS Faculty Advisors 2 of 5. 

WHEN DONE CORRECTLY, THE FACULTY ADVISORS FILE WILL BE ON LANDSCAPE ON 2 

PAGES 

13. Close the 1A Faculty Advisors table by clicking the Close Object in the upper right corner of the object 

 

CREATE A QUERY 

Recall..Tables, an object, are the foundation of an Access database because all of the data is stored in one 

or more tables.  You can use the data stored in tables in other database objects such as queries, forms, and 

reports.  Each object has a unique icon associated with it to distinguish the type of object.  

A Query is a database object that retrieves specific data from one or more database objects – either tables or 

other queries – and then, in a single datasheet, displays only the data that you specify when you design the 

query.  The word query means to ask a question.  Think of a query as a question formed in a manner that 

Access can answer such as: How many students are enrolled in Accounting? or How many students have an 

outstanding balance? or How many students are Marketing Majors?  

A Select Query is one type of Access query.  A select query, also called a simple select query, retrieves data 

from one or more tables or queries and then displays the selected data in a datasheet.  A select query creates 

a subset of the data to answer specific questions; for example, Which students live in Austin, TX?  

The objects from which a query selects the data are referred to as the query’s data source. In the following 

exercise you will create a Simple Query using the Wizard which provides step by step guidance through the 

process.  The process involves selecting the data source and indicating the fields that you want to include in 

the query results.   

The query or question you will answer is What is the name, email address, phone number and Student ID 

of every student? 

Create a Query Using Simple Query Wizard 
1. Click Create tab, in the Queries group, click Query Wizard.  

 
 

2. In the New Query dialog box, be sure Simple Query Wizard is selected and click OK.  

If a security message displays, click Open 

Note:  In the wizard, the displayed table or query name is the object that was last selected on the 
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Navigation Pane.  Click the down arrow on the right of Tables/Queries and if needed select Your IA 

Students   

3. Under Available Fields, click Last Name, click Add Field (the right arrow) to move the field to the 

Selected Fields list on the right.  Double-click the First Name field to add the field to the Selected 

Fields list 

Note:  Use either method to add fields to the Selected Fields list.  Fields can be added in any order. 

4. Use the Add Field (right arrow) or double click to add the following fields to the Selected Fields list in 

the order specified:  Email, Phone, and Student ID. Use the down arrow or scroll bar to view all fields 

Note: selecting these five fields will answer the question, What is the name, email address, phone 

number and Student ID of every student? 

 

 
 

5. Click Next 

6. Click in the What title do you want for your query? box, edit/type so the query name is Your Initials 

1A All Students Query; Click Finish.  

7. Select all the columns and apply Best Fit and Save 

8. In any record, click in the Last Name field to cancel the selection.  

Note: A select query selects – pulls out and displays – only the information from the data source that 

you request, including the specified fields.     

9. Click the File tab, click Print, click Print Preview.  

 

 

10. In the Data group, click PDF or XPS, navigate to your Access folder and save the object as 

Your Initials All Students Query 3 of 5 

11. Click Close Print Preview 

12. In the object window, Close the query. 

Prep for 3 of 5 
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CREATE AND PRINT A FORM 

A form is an Access object where you can enter data, edit data, or display data from a table or query.  In a 

form, the fields are laid out in an attractive format on the screen, which makes working with the database 

easier for those who must enter and look up data. The default layout is simple with each field in a row.  More 

advance design features are presented in a later Chapter.  

One type of form displays only one record at a time.  Such a form is useful not only to the individual who 

performs the data entry – typing in the records – but also to anyone who has the job of viewing information in 

the database.  For example, when you visit the Records Office at your college to obtain a transcript, someone 

displays your record on the screen. For the viewer, it is much easier to look at one record at a time using a 

form than to look at all of the student records in the database table.    

1. If needed open the Navigation Pane.  Drag the edge of the Navigation Pane if needed to display the 

full object name  

2. Right click on Your 1A Students table and view the menu of options 

3. Click Open, to display the table in the object window.  Notice there are 11 fields in the table. Close the 

Navigation Pane.  

Note:  You can also double-click on the object to open it 

4. On the Create tab, in the Forms group, click Form 

 
 

Note: The Form tools creates a form based on a selected object.  The form displays all of the fields 

from the underlying data source - one record at a time - in a simple top-to-bottom format with all 11 

fields in a single or two columns.  You can use this form as it displays, or you can modify it.  Records 

that you create or edit in a form are automatically added to or updated in the underlying table also 

known as the data source.  

 

By default the new form displays in Layout view. In Layout View you can make changes to elements of 

an object while it is opened and displays the data from the data source.  Each field in the form displays 

the data for the first student record in Your 1A Students table. Also notice the orange border around the 

object window.  

 

5. Observe the three buttons on the bottom right of the status bar. The three buttons are:  Form View, 

Layout View, and Design View.  These are similar to other views other applications such as Excel or 

Word.  The Layout View is active (the middle button) is the Layout View.  Notice in the photo below, 

the orange border on top of the buttons.  Point to each to display the ScreenTip 
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6. Click Form View to view the results.  The orange border goes away. 

In Form view, you can view the records, create a new record, edit a record, and delete a record.  You 

cannot change the layout or design of the form in Form View.  Form view is useful for individuals who 

access records in your database.  Layout view is useful for individuals who design the form. 

 

 

7. In the Navigation area, click Next record two times to display the third record for Joseph Ingram. 

Note:  Use the scroll buttons to scroll among the records and to display any single record. 

8. Click Save to save the form as Your Initials 1A Student Form 

 

9. Click the File tab, click Print, on the right, click Print – do not click Print Preview because you are 

going to print a single record – not all the records.   

10. In the Print dialog box, under Print Range, click the Selected Record(s) option button and click Setup 

11. In the Page Setup dialog box, click the Columns tab.  Under Column Size, double click in the Width 

box, type 7.5. Click Cancel twice because you will print an electronic copy.  

 

 
 

 

 

 

Select a Record and Save as a PDF File 

12. Return to you form. To select a record, click on the record 

selector bar located on the left of the form. After clicking on 

it, it will become solid black. 

13. Click the External Data tab, in the Export group 

 

Prep for 4 of 5 
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TIP:   Forms are usually not printed. The default width for a form created with the form command is larger 

than most printers can handle to print on one page.  If you do not change the width, the form will print on 

two pages because the column flows over the margins allowed by the printer.  If, after changing the width to 

7.5, your form still prints on two pages, enter a different value such as 7 or 6.5 

 

14. Click PDF or XPS; navigate to your Access folder, in the file name box type 1A Student Form 4 of 5 

and in the lower right corner of the dialog box, click Options.  The Options Dialog box will open.  Under 

Range, click the Selected records option button and click OK. 

 
 

Click Publish.   

 

When done correctly, only one record is saved and published 

 

15. Close the object window. Close the query. 
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CREATE, MODIFY AND PRINT A REPORT 

A report is a database object that displays the fields and records from a table or query in an easy-to-read 

format suitable for printing.  Create professional-looking reports to summarize database information.  

When you create a report using the Report tool, the default margins are 0.25 inch.  Some printers require a 

greater margin, so your report may result in two pages.  If a printer is not installed on your system, the 

electronic PDF printout might result in a two-page report.  

The Report tool creates a report in Layout view and includes all of the fields and all of the records in the data 

source which is your 1A Faculty Advisors table.  Dotted lines indicate how the report would break across pages 

if you print it now.  In Layout view, you can make quick changes to the report layout while viewing the data 

from the table. 

Modify a Report by Deleting Fields 

1. Open the Navigation Pane, open your 1A Faculty Advisors table. Close the Navigation Pane 

2. Click the Create tab, in the Reports group, click Report 

3. Click the Faculty ID field name, under the Report Layout Tools, click the Arrange tab.   

4. In the Rows & Columns group, click Select Column, press Delete.  

5. Use the same method to delete the Rank field 

Note: When fields along with the data are deleted from the report, the fields readjust by moving to the 

left.  Deleting the fields from the report does not delete the fields and data from the data source. 

Another way….Right click the field name, click Select Entire Column, then press Delete key on keyboard 

Warning: During the step below, be careful to not click in the report 

6. Click the Address field name, scroll to the right to until you see the Cell Phone field 

7. Hold the Shift key, click the Cell Phone field name 

(This selects all the fields from Address through Cell Phone and will have a colored border). 

8. In the Rows & Columns group, click Select Column and press Delete key on your keyboard 

9. Scroll to the left to observe the four remaining fields that display within the dotted lines which means 

they are within the margins of the report. 

Change Widths, Sort, Format Fields 

10. Click the Campus field name. 

11. Hold the Shift key and click the First Name field to select the first three fields. 

12. In the Rows & Columns group, click Select Column to select all three fields.  

13. Click Design tab, in the Tools group, click Property Sheet which displays on the right. 

Note:  Every item in an object has an associated Property Sheet to make precise changes to the 

properties or characteristics of selected items 

14. In the Property Sheet, click the Format tab. Click Width, type 1.5 and the press Enter.  

TIP:   Use this method to select and delete multiple columns in Layout view. 



Access – An Introduction  Page 27 of 28 

Note: The width of the selected fields changes to 1.5” and the fields readjust by moving to the left.  You 

can change the Width property if you need to move columns within the margins of a report.  In this 

report, the fields already displayed within the margins, but some reports may need this minor 

adjustment to print on one page.  

15. Close the Property Sheet.  

Another way….Select the column, drag the right edge of the column to the left to decrease the width of the 

field, or drag to the right to increase the width of the field.  

16. Click the Last Name field name.  Click Home tab, in the Sort & Filter group, click Ascending. 

Note: Access sorts the report in ascending alphabetical order by the Last Name field.  By default, tables 

are sorted in ascending order by the primary key field – in this instance, the Faculty ID field.   

Changing the sort order in the report does not change the sort order in the underlying table.  

17. At the top of the report, to the right of the green report icon, click anywhere in the title of the report to 

select the title placeholder.   

18. On the Home tab, in the Text Formatting group, click the Font Size arrow, and click 14. 

 

19. Save the report.  In the Save As dialog box, in the Report Name box, save the Report as Your 

Lastname Firstname 1A Faculty Advisors_Report and click OK 

20. On the File Tab, click Print, click Print Preview.  On the Print Preview tab in the Zoom group, click 

Two pages.  

Note: As currently formatted, the report will print on two pages, because the page number at the bottom 

of the report is positioned beyond the right margin of the report.  

21. In the Close Preview group, click Close Print Preview.   

22. Scroll down to display the bottom of the report, and then scroll right to display the page number.  Click 

the page number Page 1 of 1 and press Delete.  

Note: Because all of the data will print on one page, the page number is not necessary.  If you want the 

page number to display, drag it within the margins of the report. 

23. Display the report in Print Preview. Notice the report will now print on one page. In the Zoom group, 

click One Page.  Click Save to save the changes to the design of the report.  

 

 

24. Create a PDF electronic image and save as Your Initials 1A Faculty Advisors Report 5 of 5.  Click 

Close Print Preview.   

25. Right click on any object tab and click Close All. 

CLOSE A DATABASE AND CLOSE ACCESS 

When you close a table, any changes made to the records are saved automatically.  If you made changes to 

the structure or adjusted column widths, you will be prompted to save the table when you close the table or 

when you switch views.  Likewise, you will be prompted to save queries, forms, and reports if you made 

changes to the layout or design.  If the Navigation Pane is open when you close Access, it will display when 

you reopen the database.  When you are finished using your database, close the database and close Access.  

1. Open the Navigation Pane, increase the width of the Navigation Pane to view all the objects.  

Prep for 5 of 5 



Access – An Introduction  Page 28 of 28 

2. On the File tab, click Close to close the database.  This keeps Access open in the event you want to 

work on a different database.  

3. Click Close on the top right corner to close Access   

Submit the following five objects:  two tables, one query, one form, and one report in Canvas:  

Your Initials_1A Students_1 of 5 

Your Initials _1A Faculty Advisors 2 of 5 

Your Initials _1A All Students Query 3 of 5 

Your Initials 1A Student Form 4 of 5 

Your Initials 1A Faculty Advisors_Report 5 of 5 

 


